
SimpleCoat Series Operation Manual

PN 23100600

for use with SimpleCoat Software version 2.10.18

on SimpleCoat (PN 23100006 or 23100007) & SimpleCoat TR (PN
23100008 or 23100009) & SimpleCoat TR Large (PN 2310009)

GPD Global® Documentation Department
GPD Global®, Inc.

611 Hollingsworth Street,
Grand Junction, CO 81505USA

+1.970.245-0408
request@gpd-global.com

www.gpd-global.com

12/09/2020

mailto:request@gpd-global.com
http://www.gpd-global.com


 SimpleCoat Series Operation Manual  

Table of Contents
Revision notes ...................................................................................................................................................... iii

Legal .....................................................................................................................................................................  iv

Trademarks ...................................................................................................................................................  iv

Warranty .......................................................................................................................................................  iv

Disclaimers ....................................................................................................................................................  v

Notices ...........................................................................................................................................................  v

Safety labels .................................................................................................................................................  vi

Chapter 1. System overview ...............................................................................................................................  1

1. Theory of operation ..................................................................................................................................  1

2. System requirements .................................................................................................................................  2

3. Specifications ............................................................................................................................................  3

4. Special features .........................................................................................................................................  5

Chapter 2. Installation and setup ......................................................................................................................  7

1. Installation ................................................................................................................................................. 7

2. Operating software .................................................................................................................................... 8

2.1. Installing software .......................................................................................................................... 8

2.2. Uninstalling software .....................................................................................................................  8

3. Power on and setup ..................................................................................................................................  9

3.1. Pressure differential switch setup ................................................................................................  10

3.2. Calibrating heads .........................................................................................................................  11

Chapter 3. Operating safety .............................................................................................................................  15

Chapter 4. User interface .................................................................................................................................  16

1. Controls ...................................................................................................................................................  16

2. Indicators ................................................................................................................................................. 17

Chapter 5. Operations ....................................................................................................................................... 18

1. Start up .................................................................................................................................................... 18

2. Shutdown ................................................................................................................................................. 18

3. Emergency shutdown .............................................................................................................................. 18

4. Homing the gantry ..................................................................................................................................  18

5. Set up for processing ..............................................................................................................................  19

6. Calibrating needle ...................................................................................................................................  20

7. Purging a valve .......................................................................................................................................  22

8. Loading a program .................................................................................................................................  22

9. Running a program .................................................................................................................................  23

10. Valve adjustments .................................................................................................................................  23

10.1. Adjusting dispense valve ...........................................................................................................  24

10.2. Adjusting spray valve ................................................................................................................  24

10.2.1. How to adjust spray valve ..............................................................................................  25

Chapter 6. Programming .................................................................................................................................. 26

1. Diagram design .......................................................................................................................................  26

 i



 SimpleCoat Series Operation Manual  

2. Setting parameters ................................................................................................................................... 27

3. Creating a program .................................................................................................................................  29

3.1. Teach a program ..........................................................................................................................  29

3.2. Add program using image ...........................................................................................................  34

3.2.1. Image programming requirements ....................................................................................  37

3.3. Add program using values ........................................................................................................... 38

3.4. Combining two programs ............................................................................................................  41

3.5. Teach subboards program ............................................................................................................  42

4. Editing a program ...................................................................................................................................  48

5. Adjusting purge time ..............................................................................................................................  52

6. Tilt and rotate considerations .................................................................................................................  53

6.1. Tilt and rotate rules .....................................................................................................................  53

6.2. Tilt and rotate valve positions .....................................................................................................  54

6.3. Tilt and rotate sequence - sample ................................................................................................ 54

Chapter 7. Maintenance and servicing ...........................................................................................................  55

1. Maintenance schedule .............................................................................................................................  55

2. Inspection procedures .............................................................................................................................  56

Chapter 8. Troubleshooting .............................................................................................................................. 58

1. Fault diagnosis ........................................................................................................................................  58

Chapter 9. System management ......................................................................................................................  60

1. Software version .....................................................................................................................................  60

2. Security ...................................................................................................................................................  60

3. Machine parameters ................................................................................................................................  60

Chapter 10. Parts list ........................................................................................................................................  61

Index .......................................................................................................................................................................  i

 ii



 SimpleCoat Series Operation Manual  

Revision notes
Summary of document changes.

Date Version Notes

07/24/2017 1.0 Original issue.

08/11/2017 1.1 Installation instructions updated.

04/04/2018 1.2 Exhaust specification updated.

10/11/2019 2.0 • Tilt and rotate content added.

• Valve models updated.

• Screen images updated.

• Specifications consolidated.

12/09/2020 2.1 • Tilt and rotate topic expanded and illustrated.

• Specifications for SimpleCoat TR Large model added.

• General specifications and Facility specifications updated.

• Installing/Uninstalling software instructions bundled together.

• Calibrating heads content expanded.

• Unnecessary steps (no E-stops) removed from Calibrating needle
instructions.

• Parts List expanded.

• Revision Notes added.

 iii



 SimpleCoat Series Operation Manual  

Legal
Trademarks, warranty, disclaimers, and notices.

Trademarks
GPD Global® is a registered trademark of GPD Global, Incorporated.

Windows® is a registered trademark of Microsoft Corporation in the United States and other countries.

Trademarks are used throughout this manual. Rather than put a trademark symbol in every occurrence of a
trademarked name, we state that we are using the names in an editorial fashion only and to the benefit of the
trademark owner with no intention of infringement on the trademark.

Warranty

General Warranty
Subject to the remedy limitation and procedures set forth in the Section “Warranty Procedures and Remedy
Limitations,” GPD Global warrants that the system will conform to the written description and specifications
furnished to Buyer in GPD Global’s proposal and specified in the Buyer’s purchase order, and that it will be
free from defects in materials and workmanship for a period of one (1) year. GPD Global will repair, or, at
its option, replace any part which proves defective in the sole judgment of GPD Global within one (1) year
of date of shipment/invoice. Separate manufacturers’ warranties may apply to components or subassemblies
purchased from others and incorporated into the system. THIS WARRANTY IS EXPRESSLY IN LIEU OF
ANY AND ALL OTHER WARRANTIES,EXPRESS OR IMPLIED, INCLUDING WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Limitations
GPD Global reserves the right to refuse warranty replacement, where, in the sole opinion of GPD Global the
defect is due to the use of incompatible materials or other damages from the result of improper use or neglect.
This warranty does not apply if the GPD Global product has been damaged by accident, abuse, or has been
modified without the written permission of GPD Global. Items considered replaceable or rendered unusable
under normal wear and tear are not covered under the terms of this warranty. Such items include fuses, lights,
filters, belts, etc.

Warranty Procedures and Remedy Limitations
The sole and exclusive remedy of the buyer in the event that the system or any components of the system
do not conform to the express warranties stated in the Section “Warranties” shall be the replacement of the
component or part. If on-site labor of GPD Global personnel is required to replace the non-warranted defective
component, GPD Global reserves the right to invoice the Buyer for component cost, personnel compensation,
travel expenses and all subsistence costs. GPD Global’s liability for a software error will be limited to the
cost of correcting the software error and the replacement of any system components damaged as a result of
the software error. In no event and under no circumstances shall GPD Global be liable for any incidental or
consequential damages; its liability is limited to the cost of the defective part or parts, regardless of the legal
theory of any such claim. As to any part claimed to be defective within one (1) year of date of shipment/invoice,
Buyer will order a replacement part which will be invoiced in ordinary fashion. If the replaced part is returned
to GPD Global by Buyer and found by GPD Global in its sole judgment to be defective, GPD Global will issue
to Buyer a credit in the amount of the price of the replacement part. GPD Global’s acceptance of any parts so
shipped to it shall not be deemed an admission that such parts are defective.
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Disclaimers
Disclaimer for GPD Global conformal coating equipment.

GPD Global conformal coating systems are intended for the stated functions at the time of sale. GPD Global is
not liable for other uses.

Notices

Operator safety
Operation of the system involves electrical power, compressed air, and mechanical devices in addition to the use
of hazardous materials. It is important that personnel operating and servicing the system are qualified and fully
understand the safety and system precautions.

For their own safety and that of the system, operator(s) must understand machine operations prior to using it.

DANGER

A dangerous condition can result for
which the safety features installed
in the system may be insufficient.

Do not operate the system beyond the
guidelines detailed in this document.

WARNING

Do not operate a damaged
machine/system/device.

Operation of a damaged machine/system/device may
cause personal injury and invalidate the warranty.

Intended use
Use of the system in any manner other than described in the documents supplied with the equipment may result
in injury or damage to the system. Examples include: removing door interlocks, bypassing safety devices,
modifications to original design, and using incompatible tools. When using the system, all precautions and
operations should be in accordance with local regulations.

Unauthorized use
The System is a self contained design avoiding contact with any accessible area; however, under certain
circumstances, it is possible to enter the system while the XYZ platform is powered up. Only fully trained,
authorized personnel may do this.

 v
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System manual

Note

This document, including the information contained herein, is the property of GPD Global, Inc. and is
considered confidential and proprietary information. It is supplied on the condition that it is not to be
used, disclosed, or reproduced in whole or in part, for any reason without prior written consent of GPD
Global, Inc.

Note

Specifications, descriptions, and all information contained in this manual are subject to change and/or
correction without notice.

Note

Although reasonable care has been exercised in the preparation of this manual to make it complete and
accurate, this manual does not purport to cover all conceivable problems or applications pertaining to
this machine.

Related information
• Chapter 3. Operating safety

Safety labels

Important

Prior to operating the system, identify all safety labels on the machine and read the corresponding
descriptions shown below.

Always wear approved safety eye protection when operating or working near the system.

In situations where inattention could cause either serious personal injury or damage to
equipment a warning notice is used.

Do not smoke near the system. Always have a fire extinguisher available for emergency use.

Before operating the system, read and understand the manuals provided with the unit.

Before performing any repairs or maintenance to the system, turn off power and lock out the
power disconnect switch.

Never place hands or tools in areas designated by this symbol when the machine is in
operation. A dangerous condition may exist.
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Warning notices are used to emphasize that hazardous voltages, current, temperatures, or other
conditions that could cause personal injury that exist with this equipment or may be associated
with its use. Only qualified personnel should enter areas designated with this symbol.

A pinch hazard from moving parts is possible. Avoid contact.

Related information
• Chapter 3. Operating safety
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Chapter 1. System overview
This manual (PN 23100600) is a reference document for operation of GPD Global conformal coating systems:

SimpleCoat, PN 23100005-0001

SimpleCoat TR, PN 23100005-0002

SimpleCoat TR Large, PN 23100009

1. Theory of operation

General theory of operation
The SimpleCoat system is designed for conformal coating spray and dispensing applications. The spray and
dispense valves are mounted on a 3-axis Cartesian platform. All spraying/dispensing takes place within the
enclosed work area. Safety limits prevent axis overrun. A flexible software program allows full control of spray/
dispense head movement.

The user interface allows the operator full control of the system, including:

• machine setup

• manual operation

• program selection

Machine status and error messages display on the computer screen and signal the user via the light tower.

Conveyor theory of operation
When the program Start button is activated, the system begins monitoring SMEMA conveyor signals. It then
waits for the input-side conveyor board sensor to register the presence of a substrate before turning on the
conveyor. When the conveyor turns on, it will load a product into the work area. The conveyor stops running a
few seconds after the work area board sensor registers the presence of a substrate.

 Chapter 1. System overview 1
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At the end of the program, the system receives a signal, per SMEMA conveyor logic, to send the substrate to the
next inline piece of equipment. For a batch type system, SMEMA plugs prevent the substrate from exiting the
work area.

Conformal coating materials
SimpleCoat is configured to utilize a variety of conformal coatings.

Note

It requires skill and experience to develop the ability to coat PCBs well with conformal coating
materials. Flexibility in operation, within the boundaries of this manual, can lead to optimized results;
trial and error often leads to the best results.

2. System requirements

Software requirements
The system consists of two programs:

SimpleCoat software for application of conformal coating

Coating Project file for storage of PCB information

Computer requirements
SimpleCoat software requires a customer-supplied laptop with:

• Ethernet connection,

• Windows 7 or newer,

• and at least 32MB of available memory.

Communication requirements
The system communicates with an on-board computer using a standard Ethernet connection.

Note

Set the IP address of the computer integrated with the machine as 192.168.1.10.

WARNING

Damage to the system or computer may
result if the ground potentials are different.

The computer must be at the same ground potential as the system.

 Chapter 1. System overview 2
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3. Specifications

Machine specifications

Description Conformal
Coating system -
SimpleCoat

Tilt & Rotate
Coating system -
SimpleCoat TR

Tilt & Rotate
Coating system -
SimpleCoat TR
Large

Dispense valveCapacity

Spray valve

Up to 2 valves total.
One spray valve and
one needle valve
are standard with
machine.

Up to 2 valves total.Only spray valves
feature Tilt & Rotate function: Tilt ±45•,
Rotate ±90•

XYZ Axis Drive Stepper motors plus ball screw

XYZ Repeatability 50 µm (0.002”)

Motion Control

Speed 350 mm/sec (13.78"/sec)

XYZ Travel with 2
Valves

430 mm x 430 mm
x 50 mm (17" x 17"
x 2.0")

394 mm x 394 mm
x 50 mm (15.5" x
15.5" x 2.0")

575 mm x 625 mm
x 50 mm (22.6" x
24.6" x 2.0")

XYZ Travel with
Spray Valve only
without tilt & rotate

457 mm x 430 mm x 50 mm (18" x 17" x 2.0")

Coating Area (X,
Y, height)

Bottom Side
Clearance

100 mm (4")

Conveyor Type Pin chain

Conveyor Width
(minimum)

50 mm (2")

Conveyor Width
(maximum)

430 mm (17") 394 mm (15.5") 1524 mm (60”)

Edge Clearance 6 mm (0.25")

Transport Height 940 mm - 965 mm (37" - 38")

Conveyor

Communication SMEMA compatible external input. Standard Ethernet
connection communication cable.

RG1 - main air
pressure

6 Bar

Regulator 2 -
material air pressure
1

0-4 Bar

Pressure Settings

Regulator 3- air
atomizer

0-4 Bar

Operating Control Minimum
Requirements

Customer-supplied laptop with Ethernet connection and
Windows 7 or newer
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Description Conformal
Coating system -
SimpleCoat

Tilt & Rotate
Coating system -
SimpleCoat TR

Tilt & Rotate
Coating system -
SimpleCoat TR
Large

Footprint(W x D x H) 1 m x 1.40 m x 1.55 m (39.37" x 55.12" x
61.02")

1.26 m x 1.35 m x
1.54 m (49.5" x 53"
x 60.5")

Weight (approximate) 275 kg (605 lbs) 432 kg (953 lbs)

Certification CE

Crating specifications

Description Conformal Coating
system - SimpleCoat

Tilt & Rotate Coating
system - SimpleCoat TR

Tilt & Rotate Coating
system - SimpleCoat TR
Large

Crate dimensions (W x
L x H)

135 cm x 145 cm x 183 cm (53” x 57” x 72”) 160 cm x 170 cm x 188
cm (63” x 67” x 74”)

Crated weight,
approximate

475 kgs (1,047 lbs) 625 kg (1,378 lbs)

Facility specifications

Description Conformal Coating
system - SimpleCoat

Tilt & Rotate Coating
system - SimpleCoat TR

Tilt & Rotate Coating
system - SimpleCoat TR
Large

Air Supply 6 bar (87 psi) dry, clean air. Included: Quick disconnect for 8 mm hose

Exhaust Port Minimum 250 CFM, 127 mm (5") diameter

100-240 VAC, 50/60 Hz, Single Phase, 10 Amp.Power

Plug: 125V unit uses 4.5m (15’) cable w/NEMA 5-15P plug. 240V unit requires
special request at time of order or non-terminated cable.

Environment specifications

Description Conformal
Coating system -
SimpleCoat

Tilt & Rotate
Coating system -
SimpleCoat TR

Tilt & Rotate
Coating system -
SimpleCoat TR
Large

Noise Levels Below 65 dbA

Materials and Chemicals There are no hazardous materials or chemicals used in the system
except for the conformal coating application/process.

Location The System must be placed in an area that is level, and away
from standing water, overhead leaks or spray areas.

Operating
Environment

Temperature and
Humidity

The system should be operated within a range of 4° C - 41° C
(39° F- 105° F) and at low humidity so no condensation forms on
the system.

 Chapter 1. System overview 4



 SimpleCoat Series Operation Manual  

Description Conformal
Coating system -
SimpleCoat

Tilt & Rotate
Coating system -
SimpleCoat TR

Tilt & Rotate
Coating system -
SimpleCoat TR
Large

Location The System must be placed in an area that is level, and away
from standing water, overhead leaks or spray areas.

Temperature and
Humidity

The system should be operated within a range of 4° C - 41° C
(39° F- 105° F) and at low humidity so no condensation forms on
the system.

Dust and
Particulates

The system should be closed tightly, including all connectors and
inlets. A dust cover is recommended if the machine is located in a
dusty environment.

Storage

Dispensing and
Spraying Valves
and associated
Piping

If the system is to be stored for long periods, valves and pipe
work should be flushed with a compatible solvent. This includes
valves, pipe work to valves and pressure containers.

Valve specifications

Valve Position Type Description Z-Slide Rotary

Head1 SPV Spray Valve Yes SimpleCoat = NO

SimpleCoatTR = YES

SimpleCoatTR Large= YES

Head2 NDV Dispense Valve Yes No

4. Special features

Dispense and spray valves
Conformal coatings are applied using two valves in tandem to achieve the best finish. The dispense and spray
valves are standard issue with the machine; the volumetric valve is an available option.

• Dispense valve - sometimes referred to as the Needle valve, applies a thin, straight line of coating for
accurate, close proximity application.

• Spray valve - provides an atomized spray line which is less precise along the edge but covers a larger area.

• Volumetric valve - volumetric pump with adjustable flow rate for masking and damming. Compatible
with Luer tip.

Note

Refer to valve-specific manuals for additional details.

External reservoirs for fluid feeding
Fluid is supplied to dispense valves via external reservoirs.

Level detects and large reservoirs are available.
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Purge and solvent cups
Stainless steel cups are positioned at the rear of the work area. Two solvent-filled park cups keep dispensing tips
clean while not in use. Two purge cups capture dispensed material during program purge steps. Each cup has
a150 ml (5 ounces) capacity and is easily removed for cleaning.

Product transport
Adjusting the system to accommodate the next product is quick and easy with a simple manual adjustment.

Internal black light for coating inspection
Because many conformal coatings fluoresce when exposed to a black light, fluorescence can help determine if
a product is fully coated. The SimpleCoat platform includes an internal black light; this enables an operator to
assess if coating is being properly applied from outside the system.

Fume extraction and exhaust port with sensor
Conformal coating generates toxic fumes that need to be removed from the working environment. Solvents used
in conformal coating are heavier than air and settle to the bottom of the work area; therefore, an exhaust port
with a filter is located below the work area cover.

Keyed maintenance mode
Adjustments are kept to a minimum on the SimpleCoat system. A lock is provided to prevent operators from
opening the front shield during processing, thus preventing fumes from escaping the dispense chamber while
also preventing operators from exposure to a moving gantry.

Tilt and rotate
The tilt and rotate models allow the spray valve in Head1 to be tilted ±45° and rotated ±90° to reach four sides
of a product.

 Chapter 1. System overview 6
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Chapter 2. Installation and setup
Installation consists of two phases:

Phase 1 - Customer typically collects all necessary information, tools, and equipment; prepares an area for
the machine; and unpacks, inspects, and levels the machine; installs and connects cables, and peripheral
equipment. Refer to Installation.

Phase 2 - GPD Global personnel typically finalizes installation and performs machine power up and final
set up. Refer to Power on and setup.

1. Installation

WARNING

The following procedures should be performed by qualified personnel in
accordance with this document and applicable local safety regulations.

Tools and material required
Spanner wrench, 15 mm

Forklift

Work gloves

Allen keys: 3 mm, 4 mm, and 5 mm

Safety glasses

Uncrating the system
1. Maneuver the system to the final operating position.

2. Disassemble the crate by unscrewing the bolts with the spanner wrench.

3. Unpack the system from the strapping and packaging.

4. Remove the bolt anchors.

Position the system
1. With the forklift, carefully remove the system from the pallet. Ensure the forks are inserted all the way

from the front or back and are long enough to completely support the pallet.

2. Move system to operation location, then lower the system to the ground, ensuring the system feet are at the
correct approximate height and all four feet touch down at the same time. Adjust the height of any feet, as
necessary.

Unpacking and inspection
1. Open the front doors and remove all packaging and strapping materials.

2. Remove all zip ties from gantry.

3. Remove tape securing cups during shipment.

4. Check the total system for damage or loose components.

 Chapter 2.
Installation and setup
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5. Install the light tower.

Leveling the system
Tools required:

Spirit level

Spanner wrench: 19 mm

Level the system to existing line of machines, or to level a batch system:

1. Place the spirit level on the front rail.

2. Observe the bubble position and adjust the front feet until the system is level.

3. Place the spirit level on the rear rail and adjust the back feet until the system is level.

4. Place the spirit level across the rail along the left side and adjust the feet until the system is level.

5. After checking for level at each system corner, close the lock nuts on the feet.

2. Operating software
The SimpleCoat system operating software allows full control of spray/dispense head movement with a user
interface that allows the operator full control of machine setup, manual operations, and program selection.

2.1. Installing software
This procedure details how to download and install SimpleCoat software on your laptop.

Before you begin
Verify the computer meets System requirements.

Procedure
1. Locate the download URL noted in the Download Instructions document accompanying your machine.

The required user ID and password are included in the document.

2. Download the SimpleCoat .zip file to a local directory.

3. Extract the.zip file.

File contents: User guide and .exe setup file used to install the SimpleCoat software

4. Run the setup.exe file.

5. Using the provided cable, plug the computer into the machine.

6. Verify the computer has the correct IP address according to Communication requirements.

7. Verify the computer is communicating with the machine. For details, refer to Connection status.

2.2. Uninstalling software
If you need to remove the SimpleCoat software from your laptop, use this procedure.

Procedure
1. Navigate to the Windows Control Panel.
2. Select Add/Remove Programs.

 Chapter 2.
Installation and setup
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3. When the Install/Uninstall screen displays, scroll to and highlight SimpleCoat.
4. Select Add/Remove.

3. Power on and setup

Before you begin

WARNING

Failure to comply with electrical specifications can result
in damage to the machine, as well as personal injury.

The electrical connection must be made by a qualified electrician and
must comply with any applicable local standards. Verify the Main Power

switch is OFF before connecting the system to the power source.

Figure 2-1. Connection ports - side panel

Item Description

1 SMEMA ports

2 Power port

3 Air port

Procedure
1. Air pressure:

a. Locate the main air regulator, attach the quick disconnect 8 mm air hose to exhaust port on the left
side of machine, and then slowly open the air valve.

b. Adjust the air regulator (in work area) and the material air pressure regulators (on side of machine) to
operating pressure settings. For details, refer to pressure settings in Specifications.

c. Set up the pressure differential switch. For details, refer to Pressure differential switch setup.

2. Power:

a. Plug the system power cord into an appropriate power plug.
b. Ensure the system is properly grounded.
c. Ensure the quality of the power is sufficient to ensure smooth operation.

3. For a batch system, verify SMEMA plugs are in place in the SMEMA ports.

4. Close all covers.

 Chapter 2.
Installation and setup
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5. Ground any pressure containers.

6. Ventilation:

a. Verify the exhaust pipe is operational.
b. Hook up ventilation system to vent port on rear panel per Specifications.

7. Turn the Main Power switch located on the front panel to ON.

8. Confirm the Emergency Stop button works as expected.

9. Manually - and slowly - move the gantry around the work area to ensure the valves will clear any potential
obstacles.

Note

In order for the gantry to move freely, the system must be in

Emergency Stop mode.

10. Verify, and tweak as needed, the machine safety check values: home location, park location, and limit
values.

CAUTION

Failure to successfully enter the machine
safety check values will return a critical

fault which shuts down the system.
If repeated machine safety check failures occur, request
qualified maintenance personnel examine and test the
system before placing the system back in operation.

11. Confirm the Home, Purge, and Park buttons in the main menu button bar operate as expected.

12. Valves:

a. Inspect each valve and its mounting bracket to ensure they are secure.

b. Run the Head Calibration procedure for both heads.

For details, refer to Calibrating heads.

13. Verify the conveyor sensors operate as expected.

On older systems, the conveyor nest sensor may need to be flipped so it looks upward.

Batch systems should have SMEMA plugs installed in both SMEMA ports.

3.1. Pressure differential switch setup

About this task
The pressure differential switch is located inside the rear cabinet door.

 Chapter 2.
Installation and setup
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Procedure
1. Test the pressure switch input:

a. Turn on the air extraction system to full power.
b. Check operation of the pressure switch input; it should be ON.
c. Turn off the air extraction system.
d. Check operation of the pressure switch input; it should be OFF.

2. Lower the extraction rate until 200-220 CFM registers at the exhaust port.

3. Repeat the pressure switch input test. If the pressure switch is OFF, adjust until input just turns ON.

4. Turn off the air extraction system and verify the pressure switch output turns OFF.

5. Lower the extraction rate to 160-180 CFM at the exhaust port.

6. Verify the pressure switch input turns OFF.

If input stays ON, slowly turn the adjustment screw clockwise until the input turns OFF.

7. Re-check the input.

The pressure switch should still turn ON with 200-220 CFM.

3.2. Calibrating heads
Head calibration requires the system be set to maintenance mode and is typically performed during initial setup.

Before you begin
Tools and equipment required:

Calibration plate

Allen key: 2 mm

Valve mounted in each head position to be calibrated

Procedure
1. If the system and laptop are not already connected and if the robot is not already homed:

a. From the main button bar, click the Connect button.
b. Click OK on the success prompt.
c. From the main button bar, click the Home button.

2. Set the Run/Maintenance keyed lock on the front control panel to Maintenance.

3. If you’ll be calibrating a spray nozzle in either head position, manually unscrew the spray cap from the
spray nozzle and set it aside.

4. Slide the calibration plate into the work area on the conveyor rails until it is snug against the board stops at
0,0 position.

 Chapter 2.
Installation and setup
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Figure 2-2. Calibration plate (PN 23116001)

5. Calibrate Head1:

a. From the main menu, select Utilities → Setup → Head Calibration

The Head Calibration window displays.

 Chapter 2.
Installation and setup
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b.

CAUTION

When either Calibrate Head button is
pressed, the system immediately moves

the gantry to the most recently taught
calibration location. It first moves the X
and Y axes, and then moves the Z axis.

Ensure a clear travel path exists
through the work area for both heads.

Click Calibrate Head 1.

c. Using the X and Y jog buttons, center the tip of the needle over the hole in the calibration plate.

d. Using the Z axis jog buttons, adjust the tip of needle so it is positioned just above the surface of the
calibration plate.

e. Click the Set button.

f. Click the OK button for each location prompt, and then select YES for the overall offset prompt.

g. Use the Z- button to raise the needle upward, away from the calibration plate.

6. Calibrate Head2:

If this head will not be used, skip this step.

a. Click Calibrate Head 2.

Head Calibration window.

 Chapter 2.
Installation and setup
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b. Using the X and Y jog buttons, center the tip of the needle over the hole in the calibration plate.

c. Using the Z axis jog buttons, adjust the tip of needle so it is positioned just above the surface of the
calibration plate.

d. Click the Set button.

e. Click the OK button for each location prompt, and then select YES for the overall offset prompt.

f. Use the Z- button to raise the needle upward, away from the calibration plate.

7. Remove the calibration plate from the work area and store for future use.

8. Close the Head Calibration window.

9. Click the Home button.

10. Set the Run/Maintenance keyed lock on the front control panel to Run.

 Chapter 2.
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Chapter 3. Operating safety

Listed notices and warnings
• Safety goggles, gloves, and long sleeve clothing should be required safety wear when working with

automated industrial systems.

• Read and understand all Notices and Safety labels.

• Read and understand all of the documentation before using the system.

• Do not disable safety features of the system.

• Do not remove any pneumatic attachment without first relieving the air pressure.

• Use only recommended parts for replacement.

• Remain clear of all moving parts while in operation.

Safety devices and guarding
The system has several built-in safety features to protect the operator from danger during normal working
operation.

WARNING

Never tamper with, bypass, or disable safety features on
the SimpleCoat system. GPD-Global, Inc. is not responsible
for any dangerous conditions encountered, mechanical or

human, because of alteration or disabling of any safety feature.

Safety circuit

The main power to the machine is monitored and controlled by a redundant safety circuit. Redundancy consists
of two parallel electrical circuits working on tandem. The safety device monitors the state of the Emergency
Stop button and other safety mechanisms, for example, an open door status. The power to the motor, as well as
pneumatic supply, are cut automatically. When the safety device is actuated, all machine power and pneumatic
motion is terminated.

Doors

The doors are monitored by limit switches. When the doors are open, the power to the pneumatics and motor are
disconnected.

Related information
• Notices
• Safety labels
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Chapter 4. User interface
These controls and indicators are the primary features typically used by the operator during operations.

1. Controls

Software controls

Figure 4-1. Main menu and button bar located across top of main window

Hardware controls

Figure 4-2. Front control panel

Item Label Description

1 ON/OFF Main power switch

2 Nozzle Air Controls cone width and pattern for
dispense valve:

• Knob - air supply pressure.

• Air control and display -
atomizes air.

3 Run/Maintenance Key switch changes between run
mode and maintenance mode.

Maintenance mode prevents the
front shield from being opened
during processing, thus preventing
fumes from escaping the dispense
chamber while also preventing
operators from exposure to a
moving gantry.

4 Emergency Stop Stops all machine movement and
aborts any active program. A
machine reboot is unnecessary.
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Figure 4-3. Side panel controls

Item Description

Material pressure regulators External material reservoirs. Each reservoir has a
pressure regulator for process optimization

Figure 4-4. Controls inside machine cabinet

Item Description

Pressure differential switch Air flow sensor for the exhaust port. Stops pneumatics
and gantry motion if flow drops below set point.

2. Indicators
Machine status and error messages display in the main window and signal the user via the light tower.

Connection status
System status is indicated and error messages are displayed at the bottom of the main window.

Light tower

Indicator Light Status Description

Green • Illuminated continuously - machine is functioning properly.

• Flashing - machine is on standby and is temporarily disabled.

Red Illuminated continuously - machine has either been stopped by the operator or there is a
problem and the machine has been disabled.

In a red light condition, the machine cannot be restarted until it is either restarted by the
operator or the disabling condition has been rectified
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Chapter 5. Operations

1. Start up

Procedure
1. Check and turn on air supply.

2. Close doors.

3. Turn on Main Power switch on machine front.

4. Release/Rotate the Emergency Stop button.

5. Check fluid air pressure.

6. Check exhaust air flow.

7. Click the Home button.

The system gantry moves to Home position.

2. Shutdown

Procedure
1. If the machine is in operation, wait until it has finished the process and returns to standby.
2. Press the Emergency Stop button.
3. Turn off Main Power switch to the system.
4. Clean any excess material from the tips of the needles.
5. Clean the valve(s) as specified by valve documents.
6. Clean the purge/park cups.

3. Emergency shutdown
The Emergency Stop button is for use if someone is endangered due to circumstances such as electric shock,
unexpected valve movement, or damage to the PCB is possible.

Procedure
1. Push the Emergency Stop button.

2. To recover from emergency stop:

a. Open the front door.
b. Remove the PCB.
c. Close the door.
d. Rotate the Emergency Stop button to release it.

4. Homing the gantry
Homing the XYZ axes ensures the gantry is properly positioned for operations.

Procedure
1. Click the Home button in the main button menu.
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The machine gantry moves immediately to the home position.

5. Set up for processing
Steps commonly performed to prepare the system for processing product.

About this task

Procedure
1. Mount heads.

2. Mount materials.

3. If processing a new product, manually adjust conveyor width to accommodate the new product size:

a. Manually loosen the two conveyor locks.

Figure 5-1. One of two conveyor locks.

b. Slide the rear conveyor rail into desired position.

c. Tighten the two conveyor locks.

Board stops and sensors do not require adjustment.

4. Solvent park cups and purge cups:

Refer to Purge and solvent cups for additional details.
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a. Fill the two park cups (at right) with solvent.
b. Verify the two purge cups (on left) are empty.

5. Load product.

6. Calibrating needle
Standard calibration sequence for needle valve.

Before you begin
Equipment required:

Calibration plate

Needle valve mounted in the head position to be calibrated

Procedure
1. If the system and laptop are not already connected and if the robot is not already homed:

a. From the main button bar, click the Connect button.
b. Click OK on the success prompt.
c. From the main button bar, click the Home button.

2. Set the Run/Maintenance keyed lock on the front control panel to Maintenance.

3. Slide the calibration plate into the work area on the conveyor rails until it is snug against the board stops at
0,0 position.

Figure 5-2. Calibration plate (PN 23116001)

4. Calibrate needle:

a. From the main menu, select Utilities → Setup → Head Calibration

The Head Calibration window displays.

 Chapter 5. Operations 20



 SimpleCoat Series Operation Manual  

b.

CAUTION

When either Calibrate Head button is
pressed, the system immediately moves

the gantry to the most recently taught
calibration location. It first moves the X
and Y axes, and then moves the Z axis.

Ensure a clear travel path exists
through the work area for both heads.

Click the applicable button: Calibrate Head 1 or Calibrate Head 2.

c. Using the X and Y jog buttons, center the tip of the needle over the hole in the calibration plate.

d. Using the Z axis jog buttons, adjust the tip of needle so it is positioned just above the surface of the
calibration plate.

e. Click the Set button.

f. Click the OK button for each location prompt, and then select YES for the overall offset prompt.

g. Use the Z- button to raise the needle upward, away from the calibration plate.

5. If a second needle/head position needs to be calibrated, repeat the prior “Calibrate needle” step for that
head.

6. Remove the calibration plate from the work area and store for future use.

7. Close the Head Calibration window.
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8. Click the Home button.

9. Set the Run/Maintenance keyed lock on the front control panel to Run.

7. Purging a valve
Purge the valves to ensure they spray or dispense correctly.

Procedure
1. Verify that purge cups are in place at the purge location.

2. Decide which valve you want to purge, and then:

• Click the Head1 button on the main button bar to purge the valve mounted in head1.

• Click the Head2 button on the main button bar to purge the valve mounted in head2.

The gantry moves immediately to the purge location for the amount of time specified in parameters.

3. Select the program file you want to download.

8. Loading a program

Procedure
1. If the system and laptop are not already connected and if the robot is not already homed:

a. From the main button bar, click the Connect button.
b. Click OK on the success prompt.
c. From the main button bar, click the Home button.

2. From the main button bar, click the Download button.

The Select File dialog displays.

3. Select the program file you want to download.

4. To run a dry test of the entire program, select the Dry Run check box.

5. Click OK.

6. At the Gcodecomplete confirmation prompt, click OK.
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7. At the download completion prompt, click OK.

9. Running a program
The most recently downloaded program will run.

About this task
A program can be run either wet (per the following instructions) or dry (select the Dry Run check box during
the Loading a program procedure).

Procedure
1. From the main button bar, click the Run button.

This screen displays.

2. Press the Start button.

To know what to expect from the system, refer to Conveyor theory of operation.

The most recently downloaded program runs.

3. As needed, end the process by pressing the Stop button.

Home or park the system after use of the Stop button; otherwise, the gantry remains where it was when the
program was aborted.

10. Valve adjustments
Once the valves are correctly set up, no further adjustments should be necessary.

Note

Adjusting gantry motion speed is typically a more effective way to change the application of coating
material than adjusting the valve.

 Chapter 5. Operations 23



 SimpleCoat Series Operation Manual  

Note

Pressure
Type

Applies to:

Fluid pressure Needle valve

Air pressure • Material

• Reservoir pressure (flow rate)

• Atomizing fluid (cone pattern width)

10.1. Adjusting dispense valve
Adjusting a dispense valve to achieve desired outcome may require several adjustment factors.

Procedure
1. Flow rate - Turn the knurled knob, located on top of the valve.

A constant flow of material is the desired result, i.e., this is how precise application is achieved.

This adjusts the flow rate of the conformal coating material.

2. Needle size - Select an appropriately sized needle for the valve.

WARNING

A new needle can lead to damaging
the dispenser or the PCB.
Needles vary in length, so recalibrate
each time a new needle is selected.

Needle size allows you to vary the coating width of an application.

3. Dispense height - Set the height of the dispense valve, using the software interface, at approximately
1-2mm above the component.

This recommended height is close enough to form a continuous bead but not so close as to conflict with a
deformed PCB board.

10.2. Adjusting spray valve
Adjusting a spray valve requires several adjustment factors: valve stroke and reservoir flow rate, plus the width
of the atomizing spray pattern.

• Valve stroke & reservoir flow rate - controlled by turning the knurled knob located on top of the valve.

• Width of atomizing spray pattern - controlled by adjusting the atomizing pressure of the fluid reservoir
air pressure with the Nozzle Air control. Refer to

Hardware controls
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10.2.1. How to adjust spray valve

When first setting up the spray valve, use the following method.

Procedure
1. Adjust air pressure to zero.

2. Remove the spray valve cap and set it aside.

3. Turn the knurled knob, located on top of the valve, until the needle stroke is down all the way.

4. Open the valve and then set material flow to a rate of 2-3 drops per second by adjusting the valve stroke
with the knurled knob and pressing the appropriate purge button (Head1 or Head2).

This process may require repeated cycles to achieve the correct flow.

5. Put the spray cap on the valve.

6. Continue using the appropriate purge button (Head1 or Head2) while adjusting the atomizing pressure
upwards until a satisfactory spray pattern is achieved on a test sample.

CAUTION

If the pressure is too high, the
material will mist; and if pressure

is too low, the material will splatter.
Guidelines: thin solvent-based conformal coatings

require very low pressures (< 1 PSI); whereas, silicone
materials can be sprayed at a pressure as high as 15 PSI.

7. Set the height of the spray valve via the software to approximately 10-20 mm above the board.

Adjusting spray height produces a variation in spray width typically 6-20 mm above the board, depending
on the viscosity of the material and the atomizing air pressure of the system.
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Chapter 6. Programming

Note

SimpleCoat software is designed to be user friendly. The operator must be familiar with Windows, plus
it is highly recommended that operators are comfortable with the most common features of the following
tools before attempting to program the system.

1. Valve adjustments

2. Diagram design

3. Creating a program, Combining two programs, or Editing a program, and testing each program step with
Dry Run

4. Purging a valve

5. Setting parameters

6. Loading a program and testing the entire program with the Dry Run check box

7. Running a program

8. Tilt and rotate considerations

1. Diagram design
The first step of creating a process is designing a coating diagram - examining the PCB and deciding how
coating is to be applied.

To design a coating diagram, you first need to identify the following area types on the board:

Areas that must not to be coated.

Areas that must be coated.

Areas that are unimportant relative to the coating process.

During the coating process, each area type can be handled by a different shape/ pattern and application by one of
the two valves.

Table 6-1. Types of conformal patterns

Pattern Type Description

Dot Circular points made by dispense or spray valve while not moving.

Line Single line of coating made by dispense or spray valve.

Area Repeated lines of coating, made by dispense or spray valve.

Circle Circular pattern made by dispense or spray valve.

Arc Arc pattern made by dispense or spray valve.
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Figure 6-1. Example of coating diagram using various conformal patterns

Item Description

1 line

2 area

3 dot

4 circle

2. Setting parameters

About this task
To enable faster programming after the material is correctly set up, the software allows you to set valve default
parameters.

Procedure
1. From the main menu, select Utilities → Setup → Machine Parameters.

The Machine Parameters window displays.
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2. Click the Nozzle Parameters button.

The Nozzle Parameters window displays.
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3. Enter desired values.

Field Description

On Delay To avoid inertia issues with material exiting the valve, assign a time value to On Delay in
order to adjust the start delay for each dispense point.

Height This value can be manually entered, adjusted, or offset from the teach pendant capture.

Area
Covered

This value helps calculate material usage and the number of passes needed during Area
Fill operations.

4. Click the Save button in the Nozzle Parameters window.

5. Click the Save & Close button in the Machine Parameters window.

3. Creating a program
There are various methods available for creating a new program.

Related information
• Section 3.1. Teach a program
• Section 3.2. Add program using image
• Section 3.3. Add program using values
• Section 3.4. Combining two programs
• Section 3.5. Teach subboards program

3.1. Teach a program
A new program can be taught by moving the gantry using the teach pendant feature in the PCB Data window.

Procedure
1. If the system and laptop are not already connected and if the robot is not already homed:

a. From the main button bar, click the Connect button. Then click OK on the success prompt.
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b. From the main button bar, click the Home button.

2. From the main menu, select Teach → New.

The PCB Data window displays.

3. Choose the Single option to program a single board.

To program an array of subboards in a panel instead, follow the Teach subboards program instructions.

4. Enter board data:

a. Enter board dimensions in the Borders and Size of Board fields in millimeters.

Parameter Definition

Borders Frames, fixtures, carriers, etc. measured from the
PCB 0,0 point (bottom right hand corner).

Size of Board Total X and Y dimensions of the substrate.

b. Enter a value for Overlap in millimeters.

This is the amount of overlap to be used for area fills. This value should be less than the value defined
for Nozzle Diameter.

5. Click the OK button to continue.

The Teach Mode window displays.
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 Note

General instructions are typically provided in the bottom left hand area of the window.

6. Click the Teach button.

The gantry immediately moves to the front of the work area, positioning Head1 to the right of the conveyor
board stop.

The operation buttons in the button bar become available.
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7. Teach a point:

a. Click an operation type button: Line, Area Fill, Arc, or Circle.

Nozzle, head, and operation parameter fields display.

b. Select desired head.

The head immediately toggles downward.

Important

Head hardware toggles immediately
when switching between heads.

Be aware that one head is always in the
toggled down position in Teach mode.

c. Select desired nozzle.

d. Using the provided XYZ buttons, move the selected head to desired XYZ coordinates.
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CAUTION

Avoid potential collisions - do NOT
assume the Z axis will move first.

When switching heads, be sure to add a
program step to move the Z axis upward in order

to avoid potential head/substrate collisions.

e. Select desired speed.

f. Click the Set button to firm the point values.

Screen instructions prompt you to enter the next point.

8. (Optional) Set up tilt and rotate for Head1:

The title and rotate function displays only on the SimpleCoat TR model and applies only to Head1. Refer
to Tilt and rotate considerations for additional details.

a. Select the program pattern step to be dispensed at an angle by Head1.
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b. Select the Rotate check box.

Head1 valve rotates 90 degrees to achieve rotation.

c. Using the provided XYZ buttons, move the Head1 nozzle to desired XYZ coordinates.

d. Select the desired option: Tilt Right or Tilt Left

Head1 valve tilts 45 degrees.

e. Click the Set button to firm the point values.

9. Teach additional program steps, as needed, following the same procedure described in the prior steps.

10. When you are done adding steps to the program, click the Home button located in the lower right hand
corner of the window.

11. When prompted, select YES to save data.

12. When prompted, select OK to save file.

Results
The program is now ready to download and run.

Related information
• Section 3. Creating a program

3.2. Add program using image
If an image file (JPG) of the PCB is available, you can use it as a guide when creating a program.

Before you begin
Image files must meet Image programming requirements.
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Procedure
1. If the system and laptop are not already connected and if the robot is not already homed:

a. From the main button bar, click the Connect button. Then click OK on the success prompt.
b. From the main button bar, click the Home button.

2. From the main menu, select File → Import → New Image.

The Open Image File dialog displays.

3. Select the JPG file you want to import and click the OK button.

The Graphic Editor screen displays.
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4. Enter board dimensions:

All units are mm by default.

a. Enter the Y and X dimensions of the PCB.

b. Enter the Max Component height of the PCB.

c. Press the Set Zero button.

The board image displays.

5. Define board corners:

a. Click cursor on the bottom right hand corner of the image.

You may zoom in on the image using the Zoom+ button.

b. Click the cursor on the top left hand corner of the image.

c. When prompted to set corners, select YES.

6. Define coating parameters:

a. Select desired Head.

b. Select desired Nozzle.

c. Click a pattern button: Point, Line, Area, Arc, or Circle.

d. Use the mouse to select and/or drag an area over the PCB image where you want to coat with the
selected pattern.

Note

Arcs and circles must be taught in clockwise direction.
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Figure 6-2. Sample board with taught patterns: area (rectangle), line, and circle.

Coordinates for the selected area are written to the file.

7. Repeat the prior step, as needed, to define the entire coating process for the board.

8. Click the Finish button.

9. Save the program.

Related information
• Section 3. Creating a program

3.2.1. Image programming requirements

Image format
Image must be JPEG format. This includes: .jpg, .jpeg, .JPG, and .JPEG

Note

Only JPEG images are recognized by the SimpleCoat import feature.

Image sizing
• Maximum size: 920 x 620 pixels

• A 640 x 480 pixel photo can be imported without having to be resized.

Note

Images larger than the recommended maximum will be automatically cropped; i.e., only the upper left
portion of the image will display.
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Board alignment
Image must be aligned horizontally/vertically as squarely as possible, i.e., not rotated at an angle.

Attention

Automatic program realignment
could cause unexpected results.

Align board properly in image.

Tips
• Scanning. Flat and low profile board can be scanned. Boards populated with tall components are not good

candidates for this method unless depth of field can be controlled to offset blurred result.

• Camera distance above board. A minimum distance from the camera of 11.5” is required to photograph a
14” wide board.

3.3. Add program using values
If the required values are known, a new program can be created by entering those values.

Procedure
1. If the system and laptop are not already connected and if the robot is not already homed:

a. From the main button bar, click the Connect button. Then click OK on the success prompt.
b. From the main button bar, click the Home button.

2. From the main menu, select File → New.

The PCB Data window displays.
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3. Choose board layout:.

• Single board - select the Single option.

• Array of subboards in a panel - select the Multiple option. Refer to Teach a subboards program for
additional detail.

4. Enter board data:

a. Enter board dimensions in the Borders and Size of Board fields in millimeters.

Parameter Definition

Borders Frames, fixtures, carriers, etc. measured from the
PCB 0,0 point (bottom right hand corner).

Size of Board Total X and Y dimensions of the substrate.

b. Enter a value for Z Height in millimeters.

c. Enter a value for Overlap in millimeters.

This is the amount of overlap to be used for area fills.

5. Click the OK button to continue.

The PCB Data window displays.
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6. To enter program step data:

a. Click a pattern button: Point, Line, Area, Arc, or Circle.

Coordinate fields display.

b. Enter coordinate values.

c. Select a nozzle type and head.

d. Enter the speed of the valve to be used in the process.
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e. Click the OK button to firm your entries.

7. Teach additional program steps, as needed, by repeating the prior step.

8. Click the Set button to firm your entries.

9. When prompted, select YES to save data.

10. When prompted, select OK to save file.

Related information
• Section 3. Creating a program

3.4. Combining two programs
It’s easy to add an existing program (set of steps) at the end of a different program.

Before you begin
Create the two programs you want to combine before proceeding.

About this task
Use this procedure to facilitate building a program that includes repetition by adding the steps from ‘file 2’ at
the end of ‘file 1’.

Procedure
1. If the system and laptop are not already connected and if the robot is not already homed:

a. From the main button bar, click the Connect button. Then click OK on the success prompt.
b. From the main button bar, click the Home button.

2. From the main menu, select File → Add.

The Add Files dialog displays.

3. Click the 1st File button.

4. Select the file that will become the initial steps of the program.

5. Click the 2nd File button.
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6. Select the file that will become the final steps of the program.

7. Click the Save As button, enter a name for the new program, and then click the OK button.

8. At the prompt, confirm that you want to proceed if you still want ‘file 2’ added to the end of ‘file 1’.

Related information
• Section 3. Creating a program

3.5. Teach subboards program
The Multiple option enables you to teach a subboard program that is then automatically applied to a panel of
multiple, identical subboards.

Procedure
1. If the system and laptop are not already connected and if the robot is not already homed:

a. From the main button bar, click the Connect button. Then click OK on the success prompt.
b. From the main button bar, click the Home button.

2. From the main menu, select Teach → New.

The PCB Data window displays.

3. Choose the Multiple option to program an array of subboards in a panel.

To program a single board instead, follow the Teach a program instructions.

Fields for multiple subboards display.
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4. Enter board data:

a. Enter board dimensions in the Borders and Size of Board fields in millimeters.

Parameter Definition

Borders Dimensions of pallet supporting the subboards;
measured from the PCB 0,0 point (bottom right
hand corner).

Size of Board Total X and Y dimensions of the pallet
supporting the subboards.

b. Enter the X and Y subboard dimensions in Size in millimeters.

c. Enter the number of subboards in the pallet in Boards for X and Y.

d. Enter the distance between subboards in Gap in millimeters for X and Y.

e. Enter a value for Overlap in millimeters.

This is the amount of overlap to be used for area fills. This value should be less than the value defined
for Nozzle Diameter.

An image of the subboard array displays based on your input.
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5. Click the OK button to continue.

The Teach Mode window displays.

 Note

General instructions are typically provided in the bottom left hand area of the window.
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6. Click the Teach button.

The gantry immediately moves to the front of the work area, positioning Head1 to the right of the conveyor
board stop.

The operation buttons in the button bar become available.

7. Teach a point:

a. Click an operation type button: Line, Area Fill, Arc, or Circle.

Nozzle, head, and operation parameter fields display.
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b. Select desired head.

The head immediately toggles downward.

Important

Head hardware toggles immediately
when switching between heads.

Be aware that one head is always in the
toggled down position in Teach mode.

c. Select desired nozzle.

d. Using the provided XYZ buttons, move the selected head to desired XYZ coordinates.

CAUTION

Avoid potential collisions - do NOT
assume the Z axis will move first.

When switching heads, be sure to add a
program step to move the Z axis upward in order

to avoid potential head/substrate collisions.

e. Select desired speed.

f. Click the Set button to firm the point values.

Screen instructions prompt you to enter the next point.
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8. (Optional) Set up tilt and rotate for Head1:

The tilt and rotate function only displays on SimpleCoat TR models and only applies to Head1. Refer to
Tilt and rotate considerations for additional details.

a. Select the program pattern step to be dispensed at an angle by Head1.

b. Select the Rotate check box.

Head1 valve rotates 90 degrees to achieve rotation.

c. Using the provided XYZ buttons, move the Head1 nozzle to desired XYZ coordinates.

d. Select the desired option: Tilt Right or Tilt Left

Head1 valve tilts 45 degrees.

e. Click the Set button to firm the point values.

9. Teach additional program steps, as needed, following the same procedure described in the prior steps.
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10. When you are done adding steps to the program, click the Home button located in the lower right hand
corner of the window.

11. When prompted, select YES to save data.

12. When prompted, select OK to save file.

Results
The program is now ready to download and run.

Related information
• Section 3. Creating a program

4. Editing a program

Procedure
1. If the system and laptop are not already connected and if the robot is not already homed:

a. From the main button bar, click the Connect button. Then click OK on the success prompt.
b. From the main button bar, click the Home button.

2. Open an existing program:

a. From the main menu, select File → Open

The Select File dialog displays.
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b. Select desired program and click OK.

The PCB Data window displays.

3. Select the program step to be edited using one of two methods - either scroll through the program and click
on the step to be edited or skip to the next step and select a visual pattern.

If you select a program step directly, the selected step is highlighted and parameter fields display.
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4. To select a program step using a visual pattern instead of clicking directly on a program step:

The program step that corresponds to the visual pattern you choose will be selected.

a. From the menu, select View Image. A visual representation of the program displays.

Note

Unselected patterns display in yellow.

b. Click the pattern in the visual representation you want to edit. The corresponding program step is
highlighted and parameter fields display.

Note

Selected patterns display in orange.
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5. From the main menu, select Modify → Edit

The OK button displays.

6. Make desired edit(s).

7. Test edited results with a dry run:

a. Click the Try button.
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b. Select YES when prompted for dry run.

The dry run starts immediately.

8. Finalize your edits:

a. Click the OK button.

b. Click the Set button to firm the point values.

c. When prompted, select YES to save data.

d. When prompted, select OK to save file.

5. Adjusting purge time

Procedure
1. If the system and laptop are not already connected and if the robot is not already homed:

a. From the main button bar, click the Connect button. Then click OK on the success prompt.
b. From the main button bar, click the Home button.

2. From the main menu, select Utilities → Setup → Machine Parameters

3. In the Machine Parameters window, enter desired value in Purge Time.
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4. Click Save & Close.

6. Tilt and rotate considerations
When top-down coating is insufficient for devices with a complex geometry, use the tilt and rotate function for
full access to all sides of your device.

6.1. Tilt and rotate rules

Rules
• Tilt and rotate functions at Head1 only.

• Margin values for tilt and rotate must be adjusted to:

– top margin value = 60 mm
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– left margin value = 45 mm

• Controls for tilt and rotate:

– can be selected in any order;

– display in the Teach Mode window for all SimpleCoat systems but only function for the tilt and rotate
models.

6.2. Tilt and rotate valve positions
Each portion of the tilt and rotate function features a set of standard pump positions.

Valve positions for tilt
Tilt Right, Tilt Left - move the valve from 0 to +/- 45 degrees about the Z axis.

Pump position Pump orientation

0• Valve is vertical.

-45• Top of valve moves left 45•.

+45• Top of valve moves right 45•.

Valve positions for rotate
Rotate - moves the valve from 0 to 90 degrees (or from 90 to 0 degrees) about the Z axis.

Pump position Pump orientation

0• Valve spray tip points at front of work area.

90• Valve spray tip points at left side of work area.

6.3. Tilt and rotate sequence - sample

Table 6-2. Sample sequence of valve positions for spraying all exposed surfaces of a device

Head 1 spray
valve

Spray area top right left front back

Tilt angle 0 +45 -45 +45 -45

Rotate angle 0 0 0 90 90
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Chapter 7. Maintenance and servicing

WARNING

Maintenance procedures should be
completed by qualified and trained personnel.

GPD Global Technical Support can perform the maintenance
or train customer personnel to do so. Contact GPD Global

Technical Support for more information about available services.

Keyed maintenance mode
Adjustments are kept to a minimum on the SimpleCoat system. When the Run/Maintenance keyed lock on
the front control panel is set to Run, operators are prevented from opening the front shield during processing,
thus preventing fumes from escaping the dispense chamber while also preventing operators from exposure to a
moving gantry.

Note

Gantry speed is restricted while the system is set to maintenance mode; i.e., high speed motion is
available only in run mode.

1. Maintenance schedule
Type of Service   

Service Area Every Shift Weekly Monthly Quarterly Biannual Annually

Spray and
Dispensing
Systems

Check fluid
pressures.

• Check for any
coating on
all fixtures
and surfaces
and clean as
necessary.

• Check for leaks
around fittings
and tighten
or replace as
necessary.

Check the
fluid pipes
for wear.

   

Electro-
Mechanical
Components

 • Check stepper
motors for
overheating
and smooth
operation.

• Check for any
chaffing of wires,

 Inspect all
moving
cables for
excessive
wear.

Manually
grease
linear
guides and
ball screws
with
lithium
grease.
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Type of Service   

Service Area Every Shift Weekly Monthly Quarterly Biannual Annually

pneumatic of
material pipes.

• Maintain air filter
on regulator

Pneumatics  Check for correct
operation.

If using
spray valves,
check fume
extraction
filter.

  If using
needle
valves,
check fume
extraction
filter.

Purge Cups Clean daily.      

Valve Tips Clean daily.      

2. Inspection procedures

Before you begin
Set the Run/Maintenance keyed lock on the front control panel to Maintenance.

Procedure
1. Cables. Inspect the cables in the flexible coupling for excessive wear.

Any worn cables should be replaced.

2. Valves. Valves should be maintained per procedures in the valve manuals.

3. Fume filter.

a. Inspect the exhaust port filter below the stainless steel work area cover.

The filter captures large particulates to allow toxic fumes to be pulled through the exhaust port at the
rear of the system.

Figure 7-1. Work area filter

 Chapter 7. Maintenance
and servicing

56



 SimpleCoat Series Operation Manual  

Figure 7-2. Work area fume extractor and board stops

b. The fume filter can be replaced by removing four fasteners.
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Chapter 8. Troubleshooting
This section is intended for use by operator and maintenance personnel.

Technical support
1. If a problem arises, try to solve it by reviewing Fault diagnosis.

2. If a problem arises that you cannot solve, note the following information and then contact GPD Global
Technical Support:

• Record all information displayed by the system at the time the problem occurred.

• Record the operation process in use when the fault occurred, including both when it occurred and what
occurred.

• If the fault is minor, attempt to repeat it. If the error is not repeatable, it may be due to operator error.

Note

In order to better diagnose machine faults, all maintenance records should be kept up-to-date, including
replacement parts and service records.

1. Fault diagnosis
Operation Other Symptoms Possible Cause Corrective Action

System is powered ON
but will not operate.

Low exhaust error
message displays.

As a mandatory safety
precaution, the exhaust
port includes a flow
sensor. If flow drops
below a set point, the
sensor prevents the
coating system from
operating.

Replace fume filter per
Inspection procedures.

 Cables are loose or not
connected.

Tighten the cables and
take corrective action.

Enclosure is open so
Safety switch is ON.

Close the Enclosure.

System is powered
ON but the PC has no
power.

The electrical enclosure
does not have power

Fuse is blown. Change the fuse.

Home sensor is out of
position.

Press the Emergency
Stop button. Move the
axis, realign the Home
sensor, and check the gap.

Homing the axes: the
head moves past the
Home Sensor and hits
the hard stop.

 

Sensor cable is loose or
disconnected.

Connect the sensor
properly.

Fuse is blown. Replace the fuse.Error occurs during
Homing sequence.

Axes is not moving.

Stepper motor cable is
loose or disconnected.

Connect stepper motor
cable properly.

X, Y, or Z axis does not
move.

Head can be moved freely
when power is ON.

The Emergency Stop
button is depressed.

Release the Emergency
Stop button.
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Operation Other Symptoms Possible Cause Corrective Action

PC indicates system is
running properly.

Fuse is blown. Replace the fuse.

Axis speed is set too high. Check the speed settings.Axis loses its position.  

Coupling is loose or has
slipped.

Check and tighten the
coupling.

Air valve on the regulator
is in OFF position or is at
low pressure.

Open the air valve and
adjust the air pressure.

Air line is blocked or
restricted.

Check and take corrective
action.

Loose fitting connection. Tighten connection.

Pneumatic actuator
failure

Pneumatics operates
slowly.

Damaged air line. Replace the air line.
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Chapter 9. System management
Topics include software version, security, and machine parameters.

1. Software version

To determine the level of SimpleCoat software in use, go to the main menu and click Help → About.

2. Security

Password
Access to various system features is controlled by a password.

Note

Contact GPD Global for additional password details.

3. Machine parameters
System parameters are typically set at the factory and are secured by a password.
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Chapter 10. Parts list

SimpleCoat system parts

Part description Location Part number

Motor, Stepper, 2 phase Gantry:

Z axis

X axis

Y axis

3500-0109

Controller, Stepper Electrical cabinet - front 2200-0468

Controller, 4 Axis Electrical cabinet - front 2200-0469

Fume Filter Ventilation system 2850-0006

Light Tower Hood 2450-0162

Sensor, Photoelectric Conveyor 3700-0233

Sensor, Proximity Conveyor 5500-0095

Sensor, Diffuse Electrical cabinet - rear 5500-0092

Sensor, Home 1 each:

Z axis

X axis

Y axis

5500-0091

Needle Package

Includes:

1 each Needle, Teflon

2 each Needle, Teflon

1 each Needle, SS 303

Needle valve 2725-0070
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